Custom Controls and Libraries

Custom Controls

By default, the Visual Basic 6 toolbox contains 20 objects or controls and a selection tool.  Controls are actually programs, which have a range of properties and events, that have been linked to graphics.  Remember that events are actions such as mouse clicks that cause code to be executed.  Visual Basic has other, less used controls, that are not in the toolbox but can be added easily.  In addition, programmers have created controls for specific purposes which can be purchased or in some cases, downloaded free from the Internet.  Usually these controls are called custom controls or may also appear under the name ActiveX or OCX controls. In short, custom controls can be thought of as pre-packaged programs that can be reused again and again for various applications. Controls that are part of Visual Basic are called Intrinsic Controls while those that are added later are called Components or Custom Controls.

The Visual Basic controls can be accessed from the Project menu by selecting Components.  There is a whole list of libraries, modules, and controls, but for now we are only interested in controls.  They can be selected by clicking the associated checkbox.  When this window is closed, the requested control is added to the toolbox.


In this example, the Windows media player control has been selected.  The toolbox will display an icon for this control and it can be added to a form.
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Figure VB Control—Windows Media Player

As another example, the Windows System Monitor control, although a single object, can chart and report on various indicators of how fast the machine is that you are using, including the processor speed.

[image: image2.jpg]8

0
o

0 %6 hea +Xs eE
)

100

ol 1TV
DI

e o e s I R
00 %Fice _Tad Proces. WI(
w0 xldeTi. Tod Proces. WI(
o em. Tod Proces. \I(
Proces.. \WT(

]

ZUser. Total





Figure VB control - System Monitor

Additional custom controls are widely available for all versions of Visual Basic. Before they can be used they must first be installed on your computer.  Some controls come with a self installing package, while others are "bare bones" and must be installed and registered using another program.  In future lessons, when you begin the interface activities, you will be using several custom controls. However, they differ somewhat in how they are installed.

Let's have a closer look at what is called a commercial custom control.  One of the controls you will be using emulates a joystick.  The control comes as an executable file that installs after the user makes a few selections.  When the control is installed it will show up in the Visual Basic Components list.
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Figure Joystick Custom Control Selected

When the joystick is added to a form and displayed in graphical mode it, becomes obvious that if you had to program it from scratch you would need to know a great deal about Visual Basic.  The pay off is that the control can be used in many different applications and you don't have to worry about how it was created!
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Figure Joystick Control

The large red dot in the center can be dragged around with a mouse to emulate the physical motion of a real joystick.

Custom controls can have many more properties than the default controls in the toolbox have.  These properties can be modified in the usual way from the properties window or in code at run time.  Many, however, have additional property dialogues that make it easy to set up the control.  The next two figures illustrate some of the setup windows for the joystick control.
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Figure Joystick Property Page for Options
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Figure Joystick Property Page for Colours

To give a preview of a custom control, the following is a simple Visual Basic application that has been compiled into an executable program.  An executable can be run without starting up Visual Basic.  Any custom controls in the program must be installed on the computer before the executable will run.  Click on the following link and select Open when the File Download dialog box appears.  See if you can move the image around using the virtual joystick.

Libraries

Libraries are collections of commonly used procedures, or pieces of program code.  As a Visual Basic program executes, it can use (call) code from stored files called Dynamic Link Libraries or DLLs.  This is actually part of the Windows operating system and DLLs can be linked to your project when it runs.

Libraries can be accessed by opening the Project menu and selecting References.  A list of the DLLs available on you computer will be shown.
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Figure Reference Window showing available Libraries

Windows applications routinely use common DLLs so that similar code does not have to be written over and over again.  An important feature of Visual Basic is that it also can use these DLLs.  For example, the procedures used by Windows to resize and move various windows are collectively called the Windows Applications Programming Interface or simply API.  Visual Basic uses many of the API DLLs to create the graphical environment.

In later lessons, you will be using several Dynamic Link Libraries to add new controls and procedures that don't exist in the stock version of Visual Basic.  For example, you will be controlling external devices such as motors and lights, and sensing when switches close.  Visual Basic does not have the controls or code procedures to do this so they will be added from Libraries developed by third party programmers and companies.

 Assigned activities

Activity 1 Build a VB Web Browser

In this activity you will add one of the built in or intrinsic controls which is not in the toolbox when you start Visual Basic.  You are going to create a "bare bones" web browser.

· Run Visual Basic 6

· Select Standard.Exe, by double clicking or selecting Standard.EXE and clicking the Open button
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Figure Project Start Options

· Open the Project menu and select Components.

· Scroll down through the list of available objects and check Microsoft Internet Controls. Click OK.
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Figure List of Components

You should see a new control appear at the bottom of the toolbox.  Draw this control on the form along with a command button and a text box.  Arrange them as in the next illustration
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Figure Form with Controls

Change a few properties.

· Command1 Button

· Caption - Browse

· Font - Arial, Bold, 10pt

· Text1 Box

· Text - Delete the Text1 default text (Note Text1="" is the same)
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Figure Modified Text box

Now add the code.  

· Double click on the Command1 (Browse) button to open its code window.  Add the following code:

· WebBrowser1.Navigate Text1
· Save the form and project.  Name them both Act1L5.

· Run the program.  

· Type a web address and click the Browse button.

[image: image12.jpg]CWN.com

SEARCH The web C cxicom |

i Home page SSRGS, v

< >

:Brnwse: N —





Figure Its a Web Browser!

What happened?  If all went according to plan, you just built a basic web browser.

Of course, you will want to make the form and the web browser display much larger.  This is an excellent example of how a simple control can be used to do a complex task with a minimum of programming. 

Save your Form and Project and add to your course portfolio.

Optional Activities

The following activities are sequences so that each builds on what you learned in the previous activity.  They are optional because they make use of coding using the code window. Coding is covered in detail in the next section.  The coding required in these activities is explained in the activity, and you don't need to know how it works.  The activities are more for you to experience working programs and have fun with them.

Optional Activity1 Stopwatch

In this activity you will create a short Visual Basic application which simulates a simple stopwatch.  The program can be modified later to add improvements.

· Start by running Visual Basic 6 and select Standard.EXE

Figure Program Start Options

· The program will open with a form, toolbox, and all the other pieces that make up the Visual Basic environment.  You need to place (draw) 3 controls on the form—a text box and 2 command buttons. If you have trouble following the instructions you will find an animation at the end of the activity that illustrates the sequence of steps. 

· First highlight the text box with a single click of the left mouse button. 
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Figure Text Box in Toolbox

Then draw the control near the top of the form by clicking on an open area in the form and, holding the left mouse button, dragging out a rectangle and then letting go (of the mouse button).

· Next draw 2 command buttons below the text box.  You can resize and drag them until your form looks something like the following:
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Figure Form with Controls

At this point this makes good sense to save your application.  

· Click the diskette icon on the toolbar or open the File menu and select Save.

VB programs require that you save both the form and the project.  

· Give the form the name optA1L6.  Give the project the same name.  From now on, save your program as you add new pieces.  You just have to click the diskette icon and don't need to add the name again.

Now you will modify a few properties so that the form makes sense to another user.  

· Move to the Properties window and select Form1 (in the small window at the top of the Properties window.  If you click once on the form, Form1 will automatically be selected in the Properties box).

· Change the Caption property to StopWatch.
· In the properties window, select the Command1 control. Change the Caption property to Start. 

· Next, select the Command2 control and change its Caption property to Stop.
· Later you can change a few more properties.  Your form should look like the following:
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Figure Form after Editing Properties

The project needs to have the necessary code added.  There are two ways to open the code window.  You can use the code window icon above the Project window or just double-click on the form or one of the controls.
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Figure Icons to Select Code Window or Form Window

· When the code window opens, select General in the Control selection window (at the top left of the code window).  You need to use several variables and you can declare them in this section (the event window should display Declarations).

· Type the following code, spelled exactly as below with commas (you can copy and paste)

Dim Starttime, Stoptime, Final

It should look like this
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Figure Project Form with Code Entered

· Next select Command1 in the control selection window (the event window should display Click).  You need to click on the drop-down arrow to the right of General to get the other controls you added.

· Type the following code.  Remember to place the code between the 2 lines of text that are already there (see the next figure)

Starttime = Now

· Next select Command2 in the control selection window.  Type the following code:

Stoptime = Now
Final = Stoptime - Starttime
Text1 = Format(Final, "hh:mm:ss")

· Your completed code window should look similar to the following
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Figure Completed Code

Note: 

If you make typing mistakes in Visual Basic which lead to a "syntax errors" the text will turn red and you may get an error message.  When you correct the error, the code line will turn black.  

Time to test the application.  

· Run the program

· When the program runs, click the Start button to start the application.  Wait a few seconds and then click the Stop button.  The elapsed time should be displayed in the Text box.  If you are still having problems, check out the following animation.

Activity 1 Animation
Notes on the code: 

The three variables are used to store time information.  When you click the Start button (Command1), the variable Starttime is set equal to the current time or Now, a special Visual Basic word that always returns your computer's current time and date.

When the Stop button (Command2) is clicked, the variable Stoptime is also set equal to Now which is obviously a later time.  The variable Final is set equal to the difference in Stoptime and Starttime or simply the elapsed time.

In the last line, the value, or contents, of the Final variable are displayed in the text box.  A special Format statement is used so that the time shows up in the hour:minute:second format.

Save your form and project and publish to your course portfolio

Optional Activity 2 Modify StopWatch

This activity extends Optional Activity 1.

· Add the following code (at the end of the code previously entered) to the specified controls.

Command1 code window:

Command2.Enabled = True
Command2 code window:

Command1.Enabled = True
Command2.Enabled = False
· Change a property for the Command2 control.  Change the Enabled property to False.

· Save the program.

· Start the program.  Explain the effect of adding the extra code and changing the Command2 property.

Save your form and project and publish to your course portfolio

Optional Activity 3 Further Modifications

This activity lets you experiment with the program you just wrote.  See if you can do the following.  Don't forget to save the program.

· Change the form's backcolor
· Change the button's backcolor (Note: you will need to change the style property to graphical)

· Change the font on the buttons (font type, larger, bold)

· Add a third command button to clear the text box once a result has been displayed (Hint: text1="" will clear the text box - that's 2 quotes without any space between)

· Keep the third (clear) button "grayed" out until the Stop button is clicked

Save your form and project and publish to your course portfolio

